Sales

SIMMS Inventory Management Software 2012

June 24, 2011
Contents

Sales ......................................................... 1

Creating a Quote ......................................... 1
  Create a Blank Quote ................................. 1
  Enter the Header Details for a Quote .......... 2
  Add an Item to a Quote ............................ 2
  Edit the Line Item for a Quote ................. 4
  Enter the Totals Information for a Quote .... 5
  Override an Item’s Taxes ......................... 5
  Clone a Quote ........................................ 6

Working with Quotes ................................... 6
  Apply a Deposit to a Quote ...................... 6
  View a Deposit Made on a Quote ............... 7
  View an Item’s Markup Details ................. 7
  View Quotes Close to Expiring ................. 7
  View an Existing Quote ............................ 8
  Print a Quote ......................................... 8
  Edit a Quote .......................................... 8
  Delete a Quote ....................................... 8

Creating a Sales Order ................................. 8
  Create a Blank Sales Order ...................... 9
  Enter the Header Details for a Sales Order... 9
  Enter the Shipping Details for a Sales Order.10
  Attach a Document to a Sales Order .......... 11
  Add an Item to a Sales Order ................... 11
Edit the Line Item for a Sales Order ........................................ 12
Enter Details in the Totals Pane of a Sales Order ................. 15
Override an Item’s Tax Rate ............................................. 15
Add Additional Information to a Bill of Lading ................. 16
Import a Quote into a Sales Order .................................... 18

Working with Sales Orders ............................................... 18
Place a Sales Order on Hold ............................................ 18
Manually Close a Sales Order ......................................... 19
Approve Sales Orders ..................................................... 19
View Sales Orders Close to Expiring ................................. 20
Create a Purchase Order Based on a Sales Order ............ 20
View a Customer’s Balance .............................................. 21
View an Existing Sales Order .......................................... 21
Print a Sales Order ........................................................ 22
Edit a Sales Order .......................................................... 22
Delete a Sales Order ....................................................... 22

Backorders from a Sales Order ........................................ 22
List the Items that are Backordered from a Sales Order .... 22
Create a Purchase Order to Replenish Backorder Quantities 23
Fill Backorder Quantities on Your Sales Orders ............ 23
Delete Backorder Quantities on a Sales Order ............. 24
Print Backorder Reports ................................................. 25

The Detail Discount Grid .................................................. 25
Enable the Detail Discount Grid ....................................... 26
Edit an Item’s Discounts .................................................. 26

Creating an Invoice ......................................................... 27
Create a Blank Invoice ..................................................... 27
Enter the Header Details for an Invoice. . . . . . . . . . 28
Enter the Shipping Details for an Invoice . . . . . . . . 28
Attach a Document to an Invoice . . . . . . . . . . . . 29
Add an Item to an Invoice . . . . . . . . . . . . . . . 30
Edit the Line Item for an Invoice . . . . . . . . . . . . 31
Enter Details in the Totals Pane of an Invoice . . . . 33
Assign Serial Numbers to an Item on an Invoice. . . . 33
Override an Item’s Tax Rate . . . . . . . . . . . . . . 34
Add Additional Details to a Bill of Lading . . . . . . . 34
Import a Sales Order or Quote into an Invoice . . . . 36
Working with Invoices . . . . . . . . . . . . . . . . . . . . . 36
Batch Process Invoices. . . . . . . . . . . . . . . . . . . . 36
Print an Invoice . . . . . . . . . . . . . . . . . . . . . . . . 37
Batch Print Invoices. . . . . . . . . . . . . . . . . . . . . . 37
View an Existing Invoice . . . . . . . . . . . . . . . . . . . 39
Edit an Invoice . . . . . . . . . . . . . . . . . . . . . . . . . 39
Process a Customer’s Return . . . . . . . . . . . . . . . 39
View a Customer’s Balance . . . . . . . . . . . . . . . . . 40
Void an Invoice . . . . . . . . . . . . . . . . . . . . . . . . . 41
Delete an Invoice. . . . . . . . . . . . . . . . . . . . . . . 41
Create a Quick Issue . . . . . . . . . . . . . . . . . . . . . . 42
Backorders from an Invoice . . . . . . . . . . . . . . . . 42
List Backorders in the Backorder Manager . . . . . . . . 43
Create a Purchase Order . . . . . . . . . . . . . . . . . . . 43
Create an Invoice for Backordered Items . . . . . . . . 44
Delete Backorder Quantities on an Invoice . . . . . . . 44
Print Backorder Reports . . . . . . . . . . . . . . . . . . . 45
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insufficient Stock for a Sales Order or an Invoice</td>
<td>45</td>
</tr>
<tr>
<td>The Sales Project Manager</td>
<td>46</td>
</tr>
<tr>
<td>Create a Sales Project</td>
<td>47</td>
</tr>
<tr>
<td>Add a Sub-Project to a Project</td>
<td>47</td>
</tr>
<tr>
<td>Create a Sales Order for a Sub-Project</td>
<td>48</td>
</tr>
<tr>
<td>Assign a Sales Order to a Sub-Project</td>
<td>48</td>
</tr>
<tr>
<td>Edit an Assigned Sales Order</td>
<td>48</td>
</tr>
<tr>
<td>Add a Note to a Project or Sub-Project</td>
<td>48</td>
</tr>
<tr>
<td>Close a Project, Sub-Project or Sales Order</td>
<td>49</td>
</tr>
<tr>
<td>View Projects or Sub-Projects that are Closed</td>
<td>49</td>
</tr>
<tr>
<td>Reopen a Sub-Project or Sales Order</td>
<td>49</td>
</tr>
<tr>
<td>Print the Project Manager Report</td>
<td>49</td>
</tr>
<tr>
<td>Delete a Project or Sub-Project</td>
<td>49</td>
</tr>
<tr>
<td>Sales Order Item Re-Allocation</td>
<td>50</td>
</tr>
<tr>
<td>Re-Allocate an Item on a Sales Order</td>
<td>50</td>
</tr>
<tr>
<td>Sales Reports</td>
<td>50</td>
</tr>
<tr>
<td>View Sales Reports</td>
<td>50</td>
</tr>
<tr>
<td>Descriptions for Some Reports</td>
<td>51</td>
</tr>
<tr>
<td>Restrict Access to a Sales Report</td>
<td>52</td>
</tr>
<tr>
<td>Order Picking</td>
<td>52</td>
</tr>
<tr>
<td>Choose a Transaction Type</td>
<td>53</td>
</tr>
<tr>
<td>Manually Enter an Item’s Details</td>
<td>53</td>
</tr>
<tr>
<td>Scan an Item’s Details</td>
<td>54</td>
</tr>
<tr>
<td>Print a Picking Report</td>
<td>54</td>
</tr>
<tr>
<td>See Also</td>
<td>55</td>
</tr>
</tbody>
</table>
SIMMS has many features to help you manage your sales workflow, such as the ability to create quotes, sales orders, invoices, and to fill backorders.

In addition, these features are integrated, creating a seamless workflow that saves you time. For example, you can import a quote into a sales order and import either a quote or sales order into an invoice. When you import one document into another, all the information from the original document is included in the destination document.

Another way to save time is to batch process your invoices. This means you can create multiple invoices at one time and print multiple invoices at one time.

When there is insufficient stock of an item for either a sales order or an invoice, you can backorder that item from those documents. In the Backorder Manager, you can manage your backorders by creating a purchase order to replenish your depleted stock and then fill your sales order or invoice when the stock becomes available.

Creating a Quote
Use SIMMS’ Quotes Manager and Quotes window to create your Quotes.

From the Quotes Manager you create a blank quote which opens in the Quotes window. And then, in the Quotes window you enter the details of your quote such as the customer’s name, and the items you are quoting on.

Create a Blank Quote
The first step in creating a quote is to create a blank quote in which you enter your quote’s details.

1. Open the Sales menu, open the Sales submenu, and then click Quotes Manager.
2. Click the New icon.

Enter the Header Details for a Quote
After creating a blank quote, you enter the header details for your quote.
1. In the **Quote** window, in the **Available until** date box, select the date your quote is valid until.

![Figure 1: Entering the header information for a quote.](image)

Your quote is valid until the date shown in the Available until date box. In the Customer list, select the customer your quote is for.

2. If you are using a foreign currency for this quote, in the **Foreign Currency** list, select the currency.

3. In the **Customer** list, select the customer your quote is for.

4. In the **Attention To** list, select your contact at this customer.

5. In the **Sales Agent** list, select the sales agent responsible for this quote.

6. In the **Header Comment** text box, type a comment.

   This comment appears on your printed quote.

**Add an Item to a Quote**

You have entered the header details for your quote. Next you add the items for which you are quoting a price.

1. In the **Quote** window’s grid, click in the **Item Code** field, and then click the **Search** icon that appears.

   ![If you click in the Item Code field, the Search icon appears. Click the Search icon to open the Enhanced Search window. In the Enhanced Search window you find and retrieve the item you want to add to your quote.](image)

The Enhanced Search window opens.
2. In the **Description** text box, type the description for your item, and then click **Find**.

Your item is listed in the Enhanced Search window’s grid.

3. Select your item, and then click **Retrieve One**.

The Enhanced Search window closes. SIMMS enters your item and its details in the Quote window’s grid.

**Tip:** There are many ways to enter an item’s details into a quote. For example, you can scan the item’s UPC code or select the item from the Stock Window.

In addition, you can type an item’s code or description in the appropriate fields and then press the Tab key. SIMMS automatically enters the remaining details for your item in the row.

Often, SIMMS is able to determine which item you want, even if you only type a portion of your item’s description or code in the appropriate field and then press the Tab key. If SIMMS is unable to determine the exact item you want, the Enhanced Search window opens, listing the most likely candidates.

**Edit the Line Item for a Quote**

If required edit your item’s details, such as its quantity or markup percentage. See Table 1: Edit an Item’s Details for a Quote.

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UM</strong></td>
<td>In this field SIMMS enters your item’s sales unit of measure. If you have not defined a specific sales unit of measure for your item, SIMMS enters your item’s standard unit of measure as its sales unit of measure. Any unit of measure relationship you have defined for your item is available in this list.</td>
</tr>
<tr>
<td>Manufacturer Lot</td>
<td>In this field you can enter a manufacturer’s lot for your item. You can either select the manufacturer’s lot from the field’s list (if any are available) or type one in the field.</td>
</tr>
</tbody>
</table>
Table 1: Edit an Item’s Details for a Quote

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exp. Date</td>
<td>In this field you select your item’s expiration date from the field’s calendar.</td>
</tr>
<tr>
<td>Comment</td>
<td>In this field you enter a comment to include with your item’s details. If your item has an extended description, SIMMS automatically enters it in this field. You can edit the extended description or replace it with a comment. The item’s extended description/comment appears on your printed quote.</td>
</tr>
<tr>
<td>Quantity</td>
<td>In this field you enter the quantity of the item you are selling. By default SIMMS enters one (1) as the quantity.</td>
</tr>
<tr>
<td>Markup%</td>
<td>In this field you add a markup percentage for your item. After changing the markup percentage for your item, its price (in the Price field) changes to reflect the adjustment you made to its markup percent.</td>
</tr>
<tr>
<td>Price</td>
<td>In this field SIMMS enter the price for your item. You can change your item’s price. After changing your item’s price its markup percentage (in the Markup% field) changes to reflect the adjusted you made to its price.</td>
</tr>
</tbody>
</table>

Enter the Totals Information for a Quote

The Totals pane appears at the bottom of the Quotes window. In this pane you can add freight costs and a final comment to your quote.

1. In the Totals pane, in the Freight text box, type the freight charges you want to add to your quote.
2. In the Final Comment text box, type a final comment that you want to add to your quote. This comment appears on your printed quote.

3. Click the Save icon.

**Override an Item’s Taxes**

When you add a customer to the Customer Manager, you assign them a tax schedule. By default, SIMMS applies the tax rates in your customer’s tax schedule to the items you sell them. You can override these taxes for each item you are quoting on.

1. In the Quote window, select an item that you want to override its taxes, and then click the Override Tax Rates icon.

   The Edit Transaction Line Item Taxes dialog box opens

2. Edit your item’s taxes, and then click Proceed.

**Clone a Quote**

You can make a copy of an existing quote.

1. Open the Quotes Manager, and then click the Clone Quote icon.

   The Clone Quotes window opens.

2. In the grid, select the quote you want to clone.

3. In the New Quote text box, type a quote number, and then click Clone.

   Your cloned quote opens in the Quote window.

4. If required edit your quote, and then click the Save icon.

**Working with Quotes**

The Quotes Manager is designed as the entry point from which you perform many of the tasks related to working with your quotes. For example, from the Quotes Manager you can open an existing quote, print a quote, or apply a deposit to a quote.
Apply a Deposit to a Quote

1. In the Quotes Manager, select a quote, and then click the Deposit icon.

2. In the Payment Type list, select your customer’s method of payment.

3. In the Payment Per Type box, type your customer’s deposit amount, and then click the Save icon.

View a Deposit Made on a Quote
You can view the deposit made on a quote in the AR - Deposit window.

- Open the Quotes Manager, select the quote that you want to view the deposit made on it, and then click the Deposit icon.

  The AR - Deposit window opens.

  The sum of the deposits applied to a quote appears under Quote Balance.

View an Item’s Markup Details
You can view an item’s markup details from the Quotes window. An item’s markup details include its unit cost, gross margin percentage, and markup percentage.

This feature is only available if you have the necessary permission enabled in the User Manager.
To enable this permission go to *Administration* > *User Manager* > *User Rights* tab > expand *Standard* > expand *Quotes*, and then clear the *Hide Cost* check box.

To view an item’s markup details do the following step:

- In the *Quote* window, select an item in the grid, and then click the *Markup Details* icon.
  
The Review Markup dialog box opens.

**View Quotes Close to Expiring**

You can view quotes close to expiring. In Global Settings, you set the number of days a quote is valid for. After which the quote expires.

To set the number of days a quote is valid for go to *Setup* > *Global Settings* > *Sales* tab, in the *Quotes expire after* box, type the number of days a quote is valid for.

1. Open the *Quotes Manager*, click the *Quotes Close to Expiration* icon.
   
The Quotes Close to Expiration window opens.
   
   Listed in the window are the quotes that are close to expiring.

2. To view the details of a quote, select the quote, and then click the *View* icon.

**View an Existing Quote**

- Open the *Quotes Manager*, select the quote you want to view, and then click the *View* icon.

**Print a Quote**

1. Open the *Quotes Manager*, select the quote you want to print, and then click the *Print* icon.
   
   Your selected quote opens in the Report window.

2. Click the *Print* icon.

**Edit a Quote**

1. Open the *Quotes Manager*, select the quote you want to edit, and then click the *View* icon.

2. Click the *Edit* icon.

3. Edit your quote, and then click the *Save* icon.
Delete a Quote
When you delete a quote the quote is permanently removed from SIMMS.

1. Open the **Quotes Manager**, select the quote you want to delete, and then click the **Delete** icon.
2. SIMMS prompts you to confirm that you want to delete the quote, click **Yes**.
3. SIMMS confirms the quote is deleted, click **OK**.

Creating a Sales Order
Use SIMMS’ Sales Order Manager and Sales Order window to create your Sales Orders.

From the Sales Order Manager you create a blank sales order that opens in the Sales Order window. And then, in the Sales Order window you enter the details of your sales order, such as your customer’s name, and the items you are selling to them.

Create a Blank Sales Order
The first step in creating a sales order is to create a blank sales order in which you enter the details of your sales order.

1. Open the **Sales** menu, open the **Sales** submenu, and then click **Sales Order Manager**.
2. Click the **New** icon.

Enter the Header Details for a Sales Order
After creating a blank sales order, you enter the header details for your sales order.

![Figure 4: Entering the header information for a sales order.](image-url)
1. In the **Customer** list, select the customer your sales order is for.

2. In the **Contact** list, select your contact at this customer.

3. In the **Agent** list, select the sales agent responsible for this sales order.

4. In the **Document #** text box, type the document number for the sales order.

5. In the **Default Location** list, select the location you want to take your items from.

   The location in this list overrides the default location for your item. When you enter an item for your invoice, SIMMS replaces the item’s default location, as assigned to it in the Item Manager, with the location you selected from the Default Location list.

6. If for this sales order you are using a foreign currency, in the **Foreign Currency** list, select the currency.

7. In the **Department** list, select a department.

8. In the **Comments** text box, type a comment for your sales order.

   This comment appears on your printed sales order.

**Enter the Shipping Details for a Sales Order**

After entering the header details for your sales order, you enter its shipping details.

1. Click the **Shipping** tab.

![Image of shipping details](Image)

Figure 5: Entering the shipping information for a sales order.
2. If you want SIMMS to mark your sales order as shipped once it is saved, click the Bypass Shipping Manager check box. The sales order will not appear in the Shipping Manager.

3. In the Proposed Receiving Date, select the date you expect the items on the sales order to arrive at your customer.

4. In the Shipping Method list, select the shipping method for the items on the sales order.

5. In the Shipping Account Number text box, type your shipping account number.

6. By default, SIMMS enters your customers primary address for its bill-to address. To change the bill-to address for this sales order, in the Bill To Address list, select an alternate bill-to address.

7. By default, SIMMS enter your customers primary address for its ship-to address. To change the ship-to address for this sales order, in the Ship To Address list, select an alternate ship-to address.

Attach a Document to a Sales Order

You can attach a document such as a Microsoft Word file, PDF or image to your sales orders. You can also view this document in the Contact Manager’s entry for your customer.

1. In the Sales Order window, click the Attach tab, and then click New Document. The Attach Documents window opens.

2. Click Browse.

The Find File window opens.

3. Locate the document you want to attach to your sales order, and then click Open.

The Find File window closes.

4. In the Attach Documents window, click Attach, and then click Upload.

SIMMS attaches your document to your sales order.

Add an Item to a Sales Order

You have entered the header and shipping details for your sales order. (Optionally, you may have attached a document to your sales order). Next, add the items you are selling to your customer.
1. Click in the **Item Code** field, and then click the **Search** icon that appears.

![Image of Item Code field with Search icon](image.jpg)

*Click in the Item Code field. The Search icon appears. Click the Search icon to open the Enhanced Search window. In the Enhanced Search dialog box you find and retrieve the item you want to add to your quote.*

The Enhanced Search window opens.

2. In the **Description** field, type the description for your item, and then click **Find**.

Your item is listed in the Enhanced Search window’s grid.

3. Select your item, and then click **Retrieve One**.

Your item’s details are entered in the Sales Order window’s grid.

**Tip:** There are many ways to enter an item’s details into a Sales Order. For example, you can scan the item’s UPC code or select the item from the Stock Window.

In addition, you can type an item’s code or description in the appropriate fields and then press the Tab key. SIMMS automatically enters the remaining details for your item in the row.

Often, SIMMS is able to determine which item you want, even if you only type a portion of your item’s description or code in the their field and then press the Tab key. If SIMMS is unable to determine the exact item you want, the Enhanced Search window opens, listing the most likely candidates.

**Edit an Item’s details**

If required, edit your item details, such as its quantity or markup percentage. See Table 2: Edit an Item’s Details for Sales Order for the fields you can edit.
Table 2: Edit an Item’s Details for a Sales Order

<table>
<thead>
<tr>
<th>Fields</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>UM</td>
<td>In this field SIMMS enters your item’s sales unit of measure. If you have not defined a specific sales unit of measure for your item, SIMMS enters your item’s standard unit of measure as its sales unit of measure. Any unit of measure relationship you have defined for your item is available in this list.</td>
</tr>
<tr>
<td>Location</td>
<td>In this field SIMMS enters the default location of your item. It is from this location that your item is taken for your sale. You can change the location your item is taken from by selecting a new location in the Location list.</td>
</tr>
<tr>
<td>Manufacturer Lot</td>
<td>In this field you can enter a manufacturer’s lot for your item. You can either select the manufacturer’s lot from the field’s list (if any are available) or type one in the field.</td>
</tr>
<tr>
<td>Exp. Date</td>
<td>In this field you select your item’s expiration date from the field’s calendar.</td>
</tr>
<tr>
<td>Alias</td>
<td>In this field you can select the alias (name) your customer uses for this item.</td>
</tr>
</tbody>
</table>
Table 2: Edit an Item’s Details for a Sales Order

<table>
<thead>
<tr>
<th>Fields</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>In this field you enter a comment to include with your item’s details. If your item has an extended description, SIMMS automatically enters it in this field. You can edit the extended description or replace it with a comment. The item’s extended description/comment appears on your printed quote.</td>
</tr>
<tr>
<td>Quantity</td>
<td>In this field you enter the quantity of the item you are selling. By default SIMMS enters one (1) as the quantity.</td>
</tr>
<tr>
<td>Back Order Qty</td>
<td>In this field you can enter a backorder quantity for your item. The backorder quantity is automatically added to the Back Order Manager.</td>
</tr>
<tr>
<td>Service</td>
<td>In this field you can select the service order your sales order is associated to. Use this field if your sales order is associated to a service or repair. To appear in this list, the service order must be created first.</td>
</tr>
<tr>
<td>Markup%</td>
<td>In this field you add a markup percentage for your item. After changing the markup percentage for your item, its price (in the Price field) changes to reflect the adjustment you made to its markup percent.</td>
</tr>
</tbody>
</table>
Enter Details in the Totals Pane of a Sales Order

The Totals pane appears at the bottom of the Sales Order window. In this pane you can add a freight charge and an extra discount to your sales order.

1. In the Totals pane, in the Freight text box, type the freight charge you want to add to your sales order.

2. In the Extra Discount % box, type the percentage of your extra discount.

   The extra discount is taken off the net total.

3. Click the Save icon.

Override an Item’s Tax Rate

When you add a customer in the Customer Manager, you assign them a tax schedule. By default, SIMMS applies the tax rates in your customer’s tax schedule to the items you sell them. You can override these taxes for each item on your sales order.

1. In the Sales Order window, select the item that you want to override its taxes, and then click the Override Tax Rates icon.
The Edit Transaction Line Item Taxes dialog box opens.

![Edit Transaction Line Item Taxes dialog box]

Figure 7: Override an item’s taxes.

2. Edit your item’s tax schedule, and then click **Proceed**.

**Add Additional Information to a Bill of Lading**

You can add additional information to your bill of lading, such as the carrier name, trailer number, and seal number.

**Note**: Your bill of lading only prints when you save your invoice. You must import your sales order into your invoice if you want the additional shipping information you entered included in your printed bill of lading.

1. In the **Sales Order** window, on the **Tools** menu, click **Additional Shipping Information**.
The Additional Shipping Information dialog box opens.

Figure 8: Adding additional shipping information to a bill of lading.

2. In the **Carrier** list, select a carrier.
3. In the **Carrier DOT No.** text box, type the Department of Transport number for the carrier.
4. In the **Request Delivery Date** box, select the date you want the items on your invoice delivered.
5. In the **Request Delivery Time** box, enter the time of day you want the items on the invoice delivered.
6. In the **Trailer Number** text box, type the trailer number.
7. In the **Seal Number** text box, type the seal number.
8. In the **Special Instructions** text box, type any special instructions you want to appear on the Straight Bill of Lading report.
9. In the **Freight Charges** list, select the shipping payment terms.
10. If you chose **3rd Party Billing** in the **Freight Charges** list, in the **Bill To** text box, type the name of the company paying for
the shipping charges, and then in the Address text box, type their address.

11. In the Shipped From list, select the location the items on the invoice are shipped from, and then click Save.

Import a Quote into a Sales Order
If you are creating a sales order based on a quote, you can import the details from the quote into your sales order. This reduces the time needed to complete your sales order.

1. Open the Sales Order Manager, create a blank sales order. Your blank sales order opens in the Sales Order window.

2. On the Tools menu, click Import from Quote. The Find Transaction window opens.

3. Select the quote you want to import into your sales order, and then click OK. The details of your imported quote are entered into the sales order.

4. If required edit your sales order, and then click the Save icon on the tool bar.

Working with Sales Orders
The Sales Order Manager is designed as the entry point from which you perform many of the tasks related to working with your sales orders. For example, from the Sales Order Manager you can open an existing sales order, approve a sales order, and view sales orders close to expiring.

Place a Sales Order on Hold
You can prevent a sales order from being imported into an invoice by placing it on hold.

1. Open the Sales Order Manager, on the Tools menu, click Sales Order On Hold.

2. In the On Hold column, click the check box for the sales order you want to place on hold, and then click OK. To remove the hold on a sales order, clear the check box.
Manually Close a Sales Order
A sales order is automatically closed when it is fully processed (fully invoiced). You can manually close an unprocessed or partially processed sales order.

1. Open the Sales Order Manager, and then click the Close Sales Order icon on the tool bar.
   The Close Sales Order window opens.
2. In the Closed column, click the check box for the sales order you want to close, and then click Save.
3. SIMMS prompts you to confirm that you want to close the sales order, click Yes.

Approve Sales Orders
You can implement an approval process for your sales order. The approval process requires that a sales order is approved before you can import it into an invoice.

To enable sales order approval go to Setup > Global Settings > Sales tab > and then click the Import Approved SO Only check box.

Only users with the status of sales agent can approve a sales order. If you do not want a sales agent to approve sales orders, you can prevent the sales agent from accessing the Approve Sales Order window.

To prevent a sales agent from accessing the Approve Sales Order window, go to Administration > User Manager > User Rights > expand Standard > expand Sales Order Manager > and then clear the Access Approve SO check box.

1. Open the Sales Order Manager, click the Approve Sales Order icon.

   ![Figure 9: Approving a sales order.](image)

In the Approved column, click the check box to approve a sales order.

2. In the Approved column, click the check box for the sales order that you want to approve, and then click Save.
View Sales Orders Close to Expiring
You can view a list of sales orders close to expiring. In Global Settings, you set the number of days a sales order is valid for. After which the sales order expires.

To set the number of days a sales order is valid for, go to Setup > Global Settings > Sales tab, in the Sales orders expire after box, type the number of days before a sales order expires.

1. Open the Sales Order Manager, click the Sales Orders Close to Expiration icon on the tool bar.

   The Documents Close to Expiration window opens. Listed in the window are all the sales order close to expiring.

2. To view a sales order, select the sales order, and then click Details.

   Your sales order opens in the Sales Order window.

Create a Purchase Order Based on a Sales Order
Before saving a sales order you can create a purchase order based on that sales orders. By doing so, you can replenish your stock at the same time you are depleting it with your sale.

1. Create a sales order, before saving your sales order, on the Tools menu, click New PO Based on Current SO.

   ![Figure 10: Creating a purchase order based on a sales order.](image)

   Click this option to create multiple purchase orders based on an item’s default vendor.

   Click this option to add an item to an existing purchase order or create a new purchase order.

   If you are creating a new purchase order for a single vendor, select the vendor from this list.

2. Do one of the following steps:
   
   - Click Create multiple documents based on item’s default vendor.

     Select this option if the items on your sales order are purchased from different vendors. SIMMS creates multiple purchase orders, one for each of your item’s default vendor.
Your items must have a default vendor assigned to them in the Item Manager.

- Click **Create one document.** Do one of the following steps: (a) To add your items to an existing purchase order, select the purchase order number in the adjacent list; or (b) to create a new purchase order, leave the list on its default setting **New**, and then in the list of vendors (bottom), select the vendor for your item.

3. Click **OK.**

After you save your sales order, SIMMS creates both a sales order and a purchase order.

**View a Customer’s Balance**

In the Customer Balance window you can view a customer’s credit on file, credit limit, and total amount owing.

1. Open the **Sales Order Manager**, select the sales order for the customer whose balance you want to view, and then click the **View** icon.

   Your selected sales order opens in the Sales Order window.

2. On the **Customer** menu, click **Customer Balance**.

   The Customer Balance window opens.

![Customer Balance window](image)

*Figure 11: Viewing a customer’s balance.*

**View an Existing Sales Order**

- Open the **Sales Order Manager**, select the sales order you want to view, and then click the **View** icon.

   Your selected sales order opens in the Sales Order window.

**Print a Sales Order**

1. Open the **Sales Order Manager**, select the sales order you want to print, and then click the **Print** icon.

   Your selected sales order opens in the Report window.
2. Click the **Print** icon □.

### Edit a Sales Order

1. Open the **Sales Order Manager**, select the sales order you want to edit, and then click the **View** icon □.

   Your selected sales order opens in the Sales Order window.

2. Click the **Edit** icon □.

3. Edit your sales order, and then click the **Save** icon □.

### Delete a Sales Order

Deleting a sales order permanently removes the sales order from SIMMS. You cannot delete a sales order if there is a payment made on it.

1. Open the **Sales Order Manager**, select the sales order you want to delete, and then click the **Delete** icon □.

2. SIMMS prompts you to confirm that you want to delete the sales order, click **Yes**.

3. SIMMS confirms the sales order is deleted, click **OK**.

### Backorders from a Sales Order

You can view backorders created from a sales order in the Backorder Manager - Sales Order window. From this window, you can replenish depleted stock by creating a purchase order. And when the stock becomes available you can fill the backorders on your original sales order.

### List the Items that are Backordered from a Sales Order

1. Open the **Sales Order Manager**, and then click the **Backorder Manager** icon □.

   The Backorder Manager - Sales Order window opens.

2. Click **Preview**.

   SIMMS lists in the grid the backordered items on your sales orders.

### Create a Purchase Order to Replenish Backorder Quantities

From the Backorder Manager - Sales Order window you can create a purchase order to replenish your backordered stock.
1. List your backordered items in the **Backorder Manager - Sales Order** window.

2. In the **Select for PO** column, click the check box for the items you want to purchase, and then click **Create PO**.

   The Reordering Purchase Order window opens.

![Figure 12: Creating a purchase order to replenish backordered items.](image)

3. (Optional) In the **Qty** column, edit the quantity of the items you are purchasing.

   By default, the quantity SIMMS enters in the Qty field is only enough to fill your backorders. If you want to purchase more items than what is required to fill your backorders, increase the quantity in the Qty field.

4. In the **Document Number** text box, type a document number.

5. Do one of the following steps:
   - If you are purchasing your items from the same vendor, in the **Vendor** list, select the vendor, and then click **Create POs**.
   - If you are purchasing your items from different vendors, click **Create POs to Default Vendors**.

   To purchase items from different vendors, those items must have a default vendor assigned to them in the Item Manager.

6. SIMMS prompts you to save your purchase order(s), click **Yes**.
Fill Backorder Quantities on Your Sales Orders
After stock becomes available, you can fill your backorder quantities on their original sales orders. After which, you can invoice any of the backordered items that you have filled.

1. List your backordered items in the Backorder Manager - Sales Order window, and then click Fill BO Qty on SO.
2. SIMMS prompts you to confirm that you want to fill the backorder quantities on your sales orders, click Yes.

SIMMS removes the backordered quantities on the sales order and increases its (sales) quantity.

Delete Backorder Quantities on a Sales Order

- List your backordered items in the Backorder Manager - Sales Order window, and then click Delete BO Qty.

SIMMS deletes all the backordered quantities for all items listed in the Backorder Manager - Sales Order window. To remove the backorder quantities for only some items, use the available filtering options to list only those items that you want to delete their backorder quantities.

Although you remove the backorder quantities for an item, the item remains on its sales order, even if it has a zero (sales) quantity. To remove an item from a sales order, open the sales order in the Sales Order window, and then delete the item.

Print Backorder Reports

1. In the Backorder Manager - Sales Order window, choose one of the available reports and its corresponding options:

   - Backorder Fill Report
     This report lists items whose backorder quantities have been filled. You can filter the results of this report by an initial date and final date. Also, you can order the items on
the report by date (most recent to oldest), customer (alphabetical) or items (alphabetical).

- **Items on Backorder**
  This report lists items that are currently on backorder. You can group the list of backordered items on the report by customer or item.

- **Backorder Status**
  This report lists backordered items that are on a purchase order. You can group the list of backordered items on the report by customer or item.

2. Click **Print**.
   
   Your selected report opens in the **Report** window.

3. Click the **Print** icon.

**The Detail Discount Grid**

The Detail Discount Grid is an optional feature that you can add to the Quotes window and Sales Order window.

Use the Detail Discount Grid to apply up to three types of discounts to an item. These discounts are quantity volume discounts, dollar volume discounts, and sales representative discounts.

The three types of discounts are linked in a hierarchy. This means that a discount you apply at the top of the hierarchy affects the discounts below it. The discount hierarchy from top to bottom is quantity volume discounts (the Qty% and Qty Amount fields), dollar volume discounts (the $ % and $ Amount), and sales representative discounts (the Sal. Rep. % and Sal. Rep. Amount fields).

When you apply a quantity volume discount (Qty%) to an item, the discount is taken off the item’s price. SIMMS enters the results of this discount into the item’s Qty Amount field. The dollar volume discount ($%) is taken off the Qty Amount value. SIMMS enters the results of this discount in the $ Amount field. The sales representative discount (Sal. Rep.%) is taken off the $ Amount value. SIMMS enters the results of this discount in the Sal. Rep. Amount field.
Because your discounts are linked in a hierarchy, it is important to keep the correct order of the columns. This ensures there is no confusion between the relationship of the discounts.

Before you make any discounts to your item, each discount amount is equal to the amount in the Price field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Qty %</th>
<th>Qty Amount</th>
<th>$%</th>
<th>$ Amount</th>
<th>Sal Rep %</th>
<th>Sal Rep Amount</th>
<th>Std Price</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.00</td>
<td>2,700.00</td>
<td>0.00</td>
<td>2,700.00</td>
<td>0.00</td>
<td>2,700.00</td>
<td>2,700.00</td>
<td>2,700.00</td>
</tr>
</tbody>
</table>

Figure 14: The Discount Section with no discounts applied.

The discounts are linked in a hierarchy. The discounts you apply to the top of the hierarchy effect the discounts below it.

<table>
<thead>
<tr>
<th>Field</th>
<th>Qty %</th>
<th>Qty Amount</th>
<th>$%</th>
<th>$ Amount</th>
<th>Sal Rep %</th>
<th>Sal Rep Amount</th>
<th>Std Price</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2.00</td>
<td>2,593.08</td>
<td>2.00</td>
<td>2,593.08</td>
<td>2.00</td>
<td>2,593.08</td>
<td>2,593.08</td>
<td>2,593.08</td>
</tr>
</tbody>
</table>

Figure 15: The Discount Section with discounts applied.

Enable the Detail Discount Grid

1. Open the Setup menu, click **Global Settings**.
   
The Global Settings dialog box opens.

2. Click the **Sales** tab, under **Options**, click the **Use detailed discount grid** check box, and then click **Save**.
   
The Detail Discount Grid is added to both the Quotes and Sales Order window.

Edit an Item’s Discounts

Table 3: Discounts Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Qty %</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>In this field you enter the percentage you want discounted from your item’s price.</td>
</tr>
</tbody>
</table>
Creating an Invoice

Use SIMMS’ Invoices Manager and Invoice window to create your invoices.

From the Invoices Manager you create a blank invoice which opens in the Invoice window. In the Invoice window you enter the details of your invoice such as your customer’s name, and the items you are selling.

Create a Blank Invoice

The first step in creating an invoice is to create a blank invoice in which you enter the details of your invoice.

1. Open the Sales menu, open the Sales submenu, and then click Invoices Manager.
2. Click the New icon.
   
   Your blank invoice opens in the Invoice window.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Qty Amount</td>
<td>In this field you replace your item’s price with a discounted price.</td>
</tr>
<tr>
<td>$ %</td>
<td>In this field you enter the percentage you want discounted from your item’s Qty Amount.</td>
</tr>
<tr>
<td>$ Amount</td>
<td>In this field you replace your item’s Qty Amount with a discounted price.</td>
</tr>
<tr>
<td>Sal. Rep. %</td>
<td>In this field you enter the percentage you want discounted from your item’s $ % price.</td>
</tr>
<tr>
<td>Sal. Rep. Amount</td>
<td>In this field you replace your item’s $ % Amount with a discounted price.</td>
</tr>
</tbody>
</table>
**Enter the Header Details for an Invoice**

After creating a blank invoice, you enter the header details for your invoice.

![Figure 16: Entering the header information for an invoice.](image)

1. On the **Header** tab, in the **Customer** list, select a customer.
2. In the **Contact** list, select your contact at this customer.
3. In the **Agent** list, select the sales agent responsible for this invoice.
4. In the **Due Date** box, select the date payment is required for your invoice.
5. In the **Document #** text box, type a document number.
6. In the **PO #** text box, type your customer’s purchase order number.
7. In the **Default Location** list, select the location you want to take your items from.
   
   The location in this list overrides the default location for your item. When you enter an item for your invoice, SIMMS replaces the item’s default location, as assigned to it in the Item Manager, with the location you selected from the Default Location list.

8. If you are using a foreign currency for this invoice, in the **Foreign Currency** list, select the currency.
9. In the **Department** list, select a department.
10. In the **Comment** text box, type a comment.
    
    This comment appears on your printed invoice.

**Enter the Shipping Details for an Invoice**

After entering the header details for your invoice, you enter its shipping details.
1. Click the **Shipping** tab.

![Figure 17: Entering shipping information for an invoice.](image)

2. If you want SIMMS to mark your invoice as shipped once it is saved, click the **Bypass Shipping Manager** check box. The invoice will not appear in the Shipping Manager.

3. In the **Proposed Receiving Date**, select the date you expect the items on the invoice to arrive at your customer.

4. In the **Shipping Method** list, select the shipping method used for the items on the invoice.

5. In the **Shipping Account Number** text box, type your shipping account number.

6. By default, SIMMS enters your customers primary address for its bill-to address. To change the bill-to address for this invoice, in the **Bill To Address** list, select an alternate bill-to address.

7. By default, SIMMS enters your customers primary address for its ship-to address. To change the ship-to address for this invoice, in the **Ship To Address** list, select an alternate ship-to address.

### Attach a Document to an Invoice

You can attach a document such as a Microsoft Word file, PDF or image to your invoice.

In addition, you can also view the same document in the Customer Manager's entry for your customer.

1. In the **Invoice** window, click the **Attach** tab, and then click **New Document**.

2. Click **Browse**.
   The Find File window opens.
3. Locate and select the document you want to attach to your invoice, and then click **Open**.

The Find File window closes.

4. In the **Attach Documents** window, click **Attach**, and then click **Upload**.

**Add an Item to an Invoice**

You have entered the header and shipping details for your invoice. (Optionally, you may have attached a document to your invoice). Next, add the items you want to invoice.

1. Click in the **Item Code** field, and then click the **Search** icon that appears.

   *Tip*: There are many ways to enter an item’s details into an invoice. For example, you can scan the item’s UPC code or select the item from the **Stock Window**.

   In addition, you can type an item’s code or description in the appropriate fields and then press the Tab key. SIMMS automatically enters the remaining details for your item in the row.

   *Often, SIMMS is able to determine which item you want, even if you only type a portion of your item’s description or code in the appropriate field and then press the Tab key. If SIMMS is unable to determine the exact*
item you want, the Enhanced Search window opens, listing the most likely candidates.

**Edit an Item’s Details**

If required in the Invoice window’s grid, edit your item’s details, such as its quantity or markup percentage. See Table 4: Edit an Item’s Details for an Invoice.

### Table 4: Edit an Item’s Details for an Invoice

<table>
<thead>
<tr>
<th>Fields</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>UM</td>
<td>In this field SIMMS enters your item’s sales unit of measure. If you have not defined a specific sales unit of measure for your item, SIMMS enters your item’s standard unit of measure as its sales unit of measure. Any unit of measure relationship you have defined for your item is available in this list.</td>
</tr>
<tr>
<td>Location</td>
<td>In this field SIMMS enters the default location of your item. It is from this location that your item is taken for your sale. You can change the location your item is taken from by selecting a new location in the Location list.</td>
</tr>
<tr>
<td>Manufacturer Lot</td>
<td>In this field you can enter a manufacturer’s lot for your item. You can either select the manufacturer’s lot from the field’s list (if any are available) or type one in the field.</td>
</tr>
<tr>
<td>Exp. Date</td>
<td>In this field you select your item’s expiration date from the field’s calendar.</td>
</tr>
<tr>
<td>Alias</td>
<td>In this field you can select the alias (name) your customer uses for this item.</td>
</tr>
</tbody>
</table>
### Table 4: Edit an Item’s Details for an Invoice

<table>
<thead>
<tr>
<th>Fields</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Comment</strong></td>
<td>In this field you enter a comment to include with your item’s details. If your item has an extended description, SIMMS automatically enters it in this field. You can edit the extended description or replace it with a comment. The item’s extended description/comment appears on your printed quote.</td>
</tr>
<tr>
<td><strong>Quantity</strong></td>
<td>In this field you enter the quantity of the item you are selling. By default SIMMS enters one (1) as the quantity.</td>
</tr>
<tr>
<td><strong>Back Order Qty</strong></td>
<td>In this field you can enter a backorder quantity for your item. The backorder quantity is automatically added to the Back Order Manager.</td>
</tr>
<tr>
<td><strong>Service</strong></td>
<td>In this field you can select the service order your sales order is associated to. Use this field if your sales order is associated to a service or repair. To appear in this list, the service order must be created first.</td>
</tr>
<tr>
<td><strong>Markup%</strong></td>
<td>In this field you add a markup percentage for your item. After changing the markup percentage for your item, its price (in the Price field) changes to reflect the adjustment you made to its markup percent.</td>
</tr>
</tbody>
</table>
Enter Details in the Totals Pane of an Invoice

The Totals pane appears at the bottom of the Invoice window. In this pane you can add a freight charge and an extra discount to your invoice.

1. In the Totals pane, in the Freight text box, type the freight charge you want to add to your invoice.

2. In the Extra Discount % box, type the percentage of your extra discount.

The extra discount is taken off the net total.

3. Click the Save icon.

Assign Serial Numbers to an Item on an Invoice

If you use serial numbers, you typically assign a serial number to your serialized items on your invoice. This requires that you select the serial number that you entered into SIMMS for your item when it was first received into inventory. If your item’s serial number is not entered into SIMMS, you can enter its serial number at the invoicing stage.

1. In the Invoice Window, click the SN icon.

2. Do one of the following steps:

   - To select an existing serial number, under Serial Number, in the select column, click the check box for the serial number you want to assign to your item.

   - To enter a serial number, click the Insert link (bottom left). SIMMS adds a row to the grid. In the SN field type your item’s serial number.

3. Click the Save Serial Numbers link.

---

<table>
<thead>
<tr>
<th>Fields</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price</td>
<td>In this field SIMMS enter the price for your item.</td>
</tr>
<tr>
<td></td>
<td>You can change your item’s price. After changing your item’s price its</td>
</tr>
<tr>
<td></td>
<td>markup percentage (in the Markup% field) changes to reflect the adjusted</td>
</tr>
<tr>
<td></td>
<td>you made to its price.</td>
</tr>
</tbody>
</table>

---

*Table 4: Edit an Item’s Details for an Invoice*
Override an Item’s Tax Rate
When you add a customer in the Customer Manager, you assign them a tax schedule. By default, SIMMS applies the tax rates in your customer’s tax schedule to the items you sell them. You can override these taxes for each item on your invoice.

1. In the Invoice window, select the item that you want to override its taxes, and then click the Override Tax Rates icon.

2. Edit the taxes for your item, and then click Proceed.

Add Additional Details to a Bill of Lading
You can add additional details to a your bill of lading, such as the carrier name, trailer number, and seal number.

As well, in the Invoice window, the information you enter in the Document No text box appears in the Order No field of your bill of lading and on your invoice. The information you enter in the User Defined 1 text box appears in the Shipment No field of your bill of lading.
1. In the **Invoice** window, on the **Tools** menu, click **Additional Shipping Information**.

![Adding additional shipping information to a bill of lading](image)

**Figure 20:** Adding additional shipping information to a bill of lading.

2. In the **Carrier** list, select a carrier.

3. In the **Carrier DOT No.** text box, type the Department of Transport number for the carrier.

4. In the **Request Delivery Date** box, select the date you want the items on your invoice delivered.

5. In the **Request Delivery Time** box, enter the time of day you want the items on the invoice delivered.

6. In the **Trailer Number** text box, type the trailer number.

7. In the **Seal Number** text box, type the seal number.

8. In the **Special Instructions** text box, type any special instructions you want to appear on the Straight Bill of Lading report.

9. In the **Freight Charges** list, select the shipping payment terms.

10. If you chose **3rd Party Billing** in the **Freight Charges** list, in the **Bill To** text box, type the name of the company paying for
the shipping charges, and then in the **Address** text box, type their address.

11. In the **Shipped From** list, select the location the items on the invoice are shipped from, and then click **Save**.

**Import a Sales Order or Quote into an Invoice**

If you are creating an invoice based on a quote or sales order, you can import the details from the quote or sales order into your invoice. This reduces the time needed to complete your invoice.

1. Open the **Invoice Manager**. Click the **New** icon.

2. Click the **Tools** menu, and then do one of the following steps:
   - Click **Import from Quote**. The **Find Transaction** window opens. Select the quote you want to import into your invoice, and then click **OK**.
   - Click **Import from Sales Order**. The **Find Transaction** window opens. Select the sales order you want to import into your invoice, and then click **OK**.

   The details of your imported document are entered into your blank invoice.

3. If required edit your invoice. Click the **Save** icon.

**Working with Invoices**

The Invoices Manager is designed as the entry point from which you perform many of the tasks related to working with invoices. For example, from the Invoices Manager you can open an existing invoice, view an invoice close to expiring, or batch process invoices.

**Batch Process Invoices**

You can generate invoices for multiple sales order at the same time.

1. Open the **Invoices Manager**, and then click the **Batch Invoicing** icon.

   You can filter your sales orders by date (All Sales Orders), or list only those sales orders that are partially filled (Partially Filled Sales Orders). If you select the option Partially Filled Sales Orders, in its adjacent list, SIMMS enters the sales orders that are partially invoiced. You can select all or some of the sales orders in the list.
In conjunction with your two filter options, you can click the Use Stock Verification check box to have SIMMS only list the sales orders that have available stock to fill them.

![Batch Invoicing](image)

**Figure 21: Batch invoicing your sales orders.**

2. Click **Generate**.
   
   Your invoices are listed in the Batch Invoicing window’s grid.

3. Click **Proceed**.
   
   SIMMS generates an invoice for each sales order listed in the dialog box.

**Print an Invoice**

1. Open the **Invoices Manager**, and then select the invoice you want to print.

2. Click the **Print** icon.
   
   Your invoice opens in the Report window.

3. Click the **Print** icon.

**Batch Print Invoices**

You can print multiple invoices at the same time.

1. Open the **Invoices Manager**, and then click the **Invoice Printing Manager** icon.
The Invoice Printing Manager Opens.

2. (Optional) Filter your list of invoices by client, sales agent, invoice number, and so on.

   An explanation of the Batch filter option: Each time you batch print your invoices, those invoices are assigned a batch number. You can filter your invoices by their batch number, so only those invoices with the same batch number display in the grid.

3. Click Generate.

   SIMMS list your invoices in the Invoice Printing Manager’s grid.

4. Do one of the following steps:

   • To print only some of the invoices listed, in the Select For Printing column, click the check box for the invoices you want to print, and then click Print.

   • To print all the invoices listed, on the Select menu, click All for Printing, and then click Print.

   Your selected invoices open in the Report window.

5. Click the Print icon.

6. After you have printed your invoices close the Report window.

7. SIMMS prompts you to confirm that your invoices printed correctly. Do one of the following steps:

   • Click Yes.

   • Click No. SIMMS prompts you to select the invoices that did not print correctly. Click OK. In the Reprint column, click the check box for the invoices you want to print, and
then click **Print**. Your invoices open in the Report window. Click the **Print** icon 📝.

**View an Existing Invoice**

- Open the **Invoices Manager**, select the invoice you want to view, and then click the **View** icon 📝.

**Edit an Invoice**

1. Open the **Invoices Manager**, select the invoice you want to edit, and then click the **View** icon 📝.
2. Click the **Edit** icon 🖥.
3. SIMMS prompts you to confirm you want to re-open your invoice, click **Yes**.
4. SIMMS displays a message that the items on the invoice will be returned to inventory, click **Yes**.
5. Edit your invoice, and then click the **Save** icon 🖕.

**Process a Customer’s Return**

You can process a customer’s return in the Invoice window. After completing the return, your customer’s account is credited the value of the return and the item is placed back into inventory.

*Note:* To process a return where the item requires repairs use the Service and Returns Manager.

1. Open the **Invoices Manager**, select your customer’s invoice.
2. Click the **Return Document** icon 📝.
3. SIMMS prompts you to confirm you want to return the items on the invoice, click **Yes**.

   SIMMS creates a credit memo. This document looks the same as your original invoice, but the charges have a negative value.
4. Remove any item on the invoice your customer is not returning. And if necessary adjust the quantity of the returned item. The result should be that only the item and its correct quantity are on the invoice.

5. Click the **Save** icon.

View a Customer’s Balance

In the Customer Balance window you can view a customer’s credit on file, credit limit, and total amount owing.

1. Open the **Invoices Manager**, select the invoice for the customer whose balance you want to view, and then click the **View** icon.

   Your selected invoice opens in the Sales Order window.

2. On the **Customer** menu, click **Customer Balance**.

   The Customer Balance window opens.

Void an Invoice

Unlike a deleted invoice, an invoice that is voided remains in SIMMS. The invoice is given the status of void.

1. Open the **Invoices Manager**, select the invoice you want to void, and then on the **File** menu, click **Void**.

2. SIMMS prompts you to confirm that you want to void this invoice, click **Yes**.

   The Date Selection dialog box opens.

3. By default the current date is set as the date for the credit memo, change the date if required, and then click **Save**.

4. SIMMS displays a question, asking if you want to create a new invoice based on the invoice you are voiding. Click either **Yes** or **No**.
5. SIMMS displays a question, asking if you want to add an extra charge to the credit memo. Do one of the following steps:
   • Click Yes. A dialog box opens. In the Select Misc. Charge Item list, select the charge you are adding to the credit memo, and then in the Quantity list, select its quantity. Click Save. SIMMS displays a question asking you to confirm that you want to save the charge, click Yes.
   • Click No.

6. A prompt displays confirming the invoice is voided, click OK. SIMMS assigns the status of void to the invoice.

SIMMS creates a credit memo and credits your customers account.

Delete an Invoice
Deleting an invoice permanently removes the invoice from SIMMS. All the items on the invoice are returned to inventory. You cannot delete an invoice if there is a payment made on it. In this case, you need to void the invoice.

Caution: To avoid loss of critical data and audit trail, it is recommended that you do not delete an invoice. Instead, void your invoice or return the items on the invoice.

1. Open the Invoices Manager, select the invoice you want to delete, and then click the Delete icon.
2. SIMMS prompts you to confirm that you want to delete the invoice, click Yes.
3. SIMMS confirms the invoice is deleted, click OK.

Create a Quick Issue
In addition to creating an invoice from the Invoices Manager, you can create an invoice in the Quick Issue window.
1. Open the **Sales** menu, open the **Sales** submenu, and then click **Quick Issue**.

![Quick Issue](image)

*Figure 25: Creating a quick issue.*

2. In the **Client** list, select your customer.

3. By default, SIMMS enter the current date in the **Transaction Date** box. If you want to change the transaction date, select a date from the date box’s calendar.

4. In the **Agent** list, select the agent responsible for this invoice.

5. In the **Document Number** text box, type a document number.

6. In the **Item** list, select the item you are invoicing.

7. In the **Quantity** box, type the quantity of the item you are invoicing, and then click **Add**.

8. If required add more items to your invoice, and then click **Save**.

**Backorders from an Invoice**

You can view backorders created from an invoice in the Backorder Manager - Invoice window. From this window, you can replenish depleted stock by creating a purchase order. And when stock becomes available you can fill your backorders on their original invoice.

**List Backorders in the Backorder Manager**

1. Open the **Invoices Manager**, and then click the **Backorder Manager** icon.

   The Backorder Manager - Invoice window opens.

2. Click **Preview**.

   SIMMS lists your backordered items in the grid.
Create a Purchase Order
From the Backorder Manager - Invoice window you can create a purchase order to replenish your backordered stock.

1. List your backordered items in the **Backorder Manager - Invoice** window.

2. In the **Select for PO** column, click the check boxes for the items you want to purchase, and then click **Create PO**.

   The Reordering Purchase Order window opens.

3. (Optional) In the **Qty** column, edit the quantities of the items you are purchasing.

   By default, the quantity SIMMS enters in the Qty field is only enough to fill your backorders. If you want to purchase more items then what is required to fill your backorders, increase the quantity in the Qty field.

4. In the **Document Number** text box, type a document number.

5. Do one of the following steps:
   
   - If the items you are purchasing comes from the same vendor, in the **Vendor** list, select the vendor, and then click **Create POs**.
   
   - If the items you are purchasing comes from different vendors, click **Create POs to Default Vendors**.

   ![Figure 26: Creating a purchase order to replenish backordered items.](image)
If you are purchasing items from different vendors, the items you are purchasing must have a default vendor set for them in the Item Manager.

6. SIMMS prompts you to save your purchase order(s), click **Yes**.

**Create an Invoice for Backordered Items**

After you have replenished your depleted stock, you can invoice your backordered quantities from the Backorder Manager - Invoices window.

*Note*: You can create only one invoice for one customer at a time. Because SIMMS automatically enters available fill quantities for all customers, you need to reset the fill quantity to zero (0) for all other customers but the one you want to create an invoice for.

1. List your backordered items in the **Backorder Manager - Invoices** window.
2. If required, set the fill quantity to zero (0) for all the customers you are not creating an invoice for at this time.
3. Click **Create Invoice**.

   SIMMS creates an invoice for your customer.

**Delete Backorder Quantities on an Invoice**

- List your backordered items in the **Backorder Manager - Invoice** window, and then click **Delete BO Qty**.

   SIMMS deletes all the backordered quantities for all items listed in the Backorder Manager - Invoice window. To remove the backordered quantities for only some items, use the available filtering options to list only those items that you want to delete their backordered quantities.

   Although you remove the backordered quantities for an item, the item remains on its invoice. To remove an item from an invoice, open the invoice in the Invoice window, and then delete the item.
Print Backorder Reports

1. In the Backorder Manager - Invoice window, choose one of the available reports and their corresponding options:
   - **Backorder Fill Report**
     This report lists items whose backorders quantities have been filled. You can filter the results of this report by an initial date and final date. Also, you can order the listed items by date (most recent to oldest), customer (alphabetical) or items (alphabetical).
   - **Items on Backorder**
     This report lists items that are currently on backorder. You can group the list of backordered items by customer or item.
   - **Backorder Status**
     This report lists backordered item’s that are on a purchase order. You can group the list of backordered items by customer or item.

2. Click **Print**.
   Your selected report opens in the Report window.

3. Click the **Print** icon.

Insufficient Stock for a Sales Order or an Invoice

When an item’s quantity (Quantity field) on either a sales order or invoice is greater than what is in stock for that item, SIMMS prompts you that there is insufficient stock on-hand for your transaction. If you choose to proceed (that is you click Yes) the Quantity Alert dialog box opens.

You have three options in the Quantity Alerts dialog box.

You can change the quantity you issued to equal the quantity you have onhand. To do this click the Change the Quantity Issued = Quantity Onhand option.
You have three options in the Quantity Alert dialog box:

- **Put the exceeded quantity on backorder**
  Click this option to backorder your insufficient stock.

- **No modification - will cause a negative stock amount**
  Click this option if you do not want to change the quantity on your transaction. This creates a negative on-hand stock value.

- **Change the Quantity Issued = Quantity Onhand**
  Click this option to change the quantity on your transaction to the quantity you actually have available in stock. SIMMS does not place any items on backorder.

If you choose not to proceed (that is you click No), return to the Sales Order or Invoice window (depending on the your transaction type), and then in the Quantity field reduce your item's quantity until it is equal to or less than your on-hand quantity.

**The Sales Project Manager**

The Sales Project Manager is designed to track sales orders for a project. Use the Sales Project Manger if you issue multiple sales orders at different stages of a project.

In the Sales Project Manager you create a sales project. Within each sales project you add your sub-projects (think of your sub-projects as stages of your sales project). You then assign sales orders to your sub-projects. As you progress through your project you can close each sub-project to indicate what has and what has not been done.

**Create a Sales Project**

1. Open the **Sales menu**, open the **Sales submenu**, and then click **Sales Project Manager**.
   
   The **Sales Project Manager** dialog box opens.

2. Click **New Project**.
   
   The Project Manager dialog box opens.
3. In the **Proj. Code** text box, type a project code.
4. In the **Description** text box, type a description for your project.
5. In the **Customer** list, select the customer your project is for.
6. In the **Start Date** box, select a start date.
   By default, SIMMS enters the current date.
7. Click **Save**.

**Add a Sub-Project to a Project**

1. In the **Sales Project Manager** dialog box, click the project you want to add a sub-project to.
2. Click **New Sub Project**.
   The Project Manager - Subproject dialog box opens.

![Figure 30: Adding a sub-project to a project.](image)

3. In the **Proj. Code** text box, type your sub-project’s code.
4. In the **Description** text box, type a description for your sub-project, and then click **Save**.

**Create a Sales Order for a Sub-Project**

1. In the **Sales Project Manager** dialog box, click a sub-project to select it, and then click **New SO**.
   A blank sales order opens in the Sales Order window.
2. Complete your sales order, and then click the **Save** icon.

**Assign a Sales Order to a Sub-Project**

1. In the **Sales Project Manager** dialog box, click the sub-project you want to assign a sales order to.
2. Click **Assign SO**.
   The **Find Transaction** window opens.
3. Select the sales order you want to assign to your sub-project, and then click OK.

Your sales order is assigned to your sub-project.

**Edit an Assigned Sales Order**

1. In the Sales Project Manager dialog box, click a sub-project’s sales order, and then click Open.

   Your sales order opens in the Sales Order window.

2. In the Sales Order window, click the Edit icon.

3. Edit your sales order, and then click the Save icon.

**Add a Note to a Project or Sub-Project**

1. In the Sales Project Manager dialog box, click either a project or sub-project, and then click Add Notes.

   The Add Notes window opens.

2. In the Add Notes window, click the New icon.

   The New Note window opens.

3. In the New Note window, in the Description text box, type a description for your note.

4. Do one of the following steps:
   - In the text box, type your note.
   - Click Load File. In the Open dialog box, locate the text file you want to add to your note, and then click Open.

5. Click Save.

**Close a Project, Sub-Project or Sales Order**

You cannot close a project when it has an open sub-project. You need to close your sub-projects first.

- In the Sales Project Manager dialog box, click either a project or sub-project, and then click Change Status to Closed.

   The text for your closed project or sub-project turns red. A closed sales order is removed from the Sales Project Manager.

**View Projects or Sub-Projects that are Closed**

- By default you can only view projects and sub-projects that are open. To view projects or subprojects that are closed, in the Sales Project Manager dialog box, clear the Incomplete check box, and then click Refresh Projects.
Reopen a Sub-Project or Sales Order

- In the Sales Project Manager dialog box, click either a closed project or sub-project (the text is red), and then click Change Status to Open.

  The text for your reopened project or sub-project displays in black.

Print the Project Manager Report

The Project Manager Report, lists your project information, sub-project information, the sales order assigned to a sub-project and the items on the sales order.

- In the Sales Project Manager dialog box, click a project, and then click View/Print.

Delete a Project or Sub-Project

- In the Sales Project Manager dialog box, click either a project or sub-project, and then click Delete.

  You cannot delete a project if there is an open sub-project below it. And, you cannot delete a sub-project if there is an open sales order below it.

Sales Order Item Re-Allocation

For unfilled sales orders, you have the option to draw the items on the sales order from different locations/manufacturer’s lots. You do this in the SO Item Re-Allocation window.

Re-Allocate an Item on a Sales Order

1. Open the Sales menu, open the Sales submenu, and then click Sales Order Item Re-Allocation.

  The Sales Order Item Re-Allocation window opens.
2. Under **Unfulfilled Orders**, select an item on the sales order.

![Figure 31: Re-allocating an item on a sales order.](image)

3. Click the **Plus Sign** to view the other locations where stock is available for your item.

   The plus sign appears dimmed if there no stock for your item in a listed location.

4. For any location/manufacturer’s lot, in the **Re-Allocate Qty** field, type the quantity of the item that you want to take from this location.

5. Click **Automatic allocation**, and then click **Save Changes**.

   SIMMS changes the location/manufacturer’s lot from which your item is taken on the original sales order.

**Sales Reports**

SIMMS has many reports related to sales. You can view all these reports from the Reports Center.

**View Sales Reports**

1. Open the **Reporting** menu, open the **Reports Center** sub-menu, and then click **Reports Center**.

   The Reports Center window opens.

2. On the **View Reports** tab, click **Sales**.

   A tree menu listing the sales reports appears.

3. Click on any of the report names, and then click **Display**.

   Depending on the report you select one of two things happens. A dialog box displays in which you select your report options and then generate the report. Or a window displays. This window is normally part of a process in which the report is part of. For example, if you click the Fulfillment Recalculation Report
and then click Display, the Fulfillment Manager opens. This is because the Fulfillment Recalculation Report is used as part of the fulfillment process.

**Descriptions for Some Reports**

Table 5: A Sample of Available Sales Reports lists some of the reports available in the Report Center and a description of the reports.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Gross Margin by Sales Agents** | Use this report to view a sales agents total sales and average gross margins. You can generate a report for quotes, sales orders, and invoices.  
You can filter your report by customer, item, date, and so on.  
Sales agents can generate a Gross Margin by Sales Agent report for themselves, but not for other sales agents.  
A sales administrator can generate this report for any sales agent. |
| **Sales Analysis Report**   | Use this report to view a graph of your daily, weekly, and monthly sales amount.  
You can filter this report by date, category, and item. |
| **Sales Summary Report**    | Use this report to view the total sales amounts by transactions, customers, or customers and the items they purchased.  
You can filter this report by date, customer, and sales agents. |
Restrict Access to a Sales Report
Because reports may contain confidential information, you have the option to restrict access to them.

1. Open the Administration menu, and then click User Manager.
2. In the list of users (leftmost), click the user for whom you want to restrict access to a report, and then click the Edit icon.
3. Click the User Rights tab.
4. In the tree menu, expand Reports, and then expand Sales.
5. In the Access Rights column, clear the check box for the report you do not want the user to see.
6. Click the Save icon.

Order Picking
Use SIMMS’ order picking tool to record and process the picking of transfers, sales orders, and invoices.

In the Order Picking window you record the details of the items you pick. You enter these details either manually or with a barcode scanner.

Choose a Transaction Type
1. Open the Sales menu, open the Sales sub-menu, and then click Order Picking.
The Order Picking window opens.

![Order Picking](image)

Figure 32: Order picking.

2. Under **Transaction Selection**, choose the type of document whose items you want to pick.
   
   For example, if you want to pick the items on an invoice, choose Invoice as your document type.

3. Click **Open**.
   
   The Find Transaction window opens.

4. Locate and select your document, and then click **OK**.
   
   The Find Transaction window closes.

**Manually Enter an Item’s Details**

1. Return to the **Order Picking** window. In the **Select** item list, select the item you want to pick.

2. In the **UM** list, select the unit of measure for your item.

3. In the **Quantity** box, type the quantity of the item you are picking.

4. In the **Mfr. Lot** list, select the item’s manufacturer’s lot.

5. In the **Location** list, select the location from which you are picking your item.
6. If your item is serialized, available serial numbers are listed in the **Serials** box. Click the check box for your item’s serial number.

   ![Figure 33: Selecting your item’s serial numbers.](image)

7. Click **Pick Selection**.

**Scan an Item’s Details**

1. In the **Order Picking** window, under **Barcode Scan** (bottom left), click the check box for the type of barcode you want to scan, and then click inside the adjacent text box.

2. Scan your item’s barcode.

   Your code appears in the text box where you placed your cursor. And your item’s information is entered in the appropriate fields under Pick Items.

   Depending on the type of barcode you scanned (UPC, serial number, or 2D) and the information it contains, you may need to manually enter some of your items details.

3. Under **Pick Items**, select and enter any missing information, and then click **Pick Selection**.

**Print a Picking Report**

1. In the **Order Picking** window, click **Print Picked**.

   The Report window opens.

2. Click the **Print** icon.
See Also
The following documents contain information related to sales:

- **Setup Guide II**
  This document covers SIMMS’ global setting, including those related to sales.

- **Sales Order Fulfillment**
  This document explains how to use the Fulfillment Manager. The Fulfillment Manager is a tool used to fill your sales orders. In the Fulfillment Manager, you can generate pick lists, invoice sales orders, create purchase orders to replenish depleted stock, and transfer items from one location to another.